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* These locations are currently operating under the Ibas brand, which was acquired by Kroll Inc in 
2006.
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INTRODUCTION

INTRODUCTION

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

Welcome to Ontrack® PowerControls™ 6.0, the mailbox recovery software that saves time, 
money, and resources when recovering Microsoft® Exchange Server data.

Ontrack PowerControls for Exchange works with your existing Exchange Server backup 
architecture and procedures, and allows you to recover individual mailboxes, folders, messages, 
attachments, calendar items, notes, and tasks directly to your production Exchange Server or any 
PST file. This eliminates time-consuming and expensive single mailbox (brick-level) backups. This 
powerful software also lets you search and create a copy of all archived email that matches a given 
keyword or criteria. 

This user guide provides step-by-step instructions for completing specific tasks on the Microsoft® 
Windows®-based platform. See the Table of Contents or the Index to locate the pages on which 
particular topics are discussed.

Use Adobe® Acrobat® to open the PDF version of this user guide. After you open the PDF file, 
click the Hand tool to view the Table of Contents hyperlinks in layout view. Then click a hyperlink 
to jump to a specific topic in the manual.

Five Major Reasons for Using Ontrack PowerControls for 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Microsoft Exchange Server

There are five primary ways you can benefit from using Ontrack PowerControls for Exchange:

Minimize the time to restore an individual mailbox. Ontrack PowerControls can slash restore 
time, making it possible to restore mail items from a previous full backup directly into your 
production Exchange Server, or directly into a new or existing PST file. This eliminates the need 
for a recovery server and the extra steps required to separately import mail back into Exchange 
Server or Microsoft® Office Outlook®.

Eliminate backups of an individual mailbox. Ontrack PowerControls for Exchange eliminates 
the need to back up individual mailboxes because they can be restored directly from an EDB file.

Minimize the time to locate all email matching specific criteria. Ontrack PowerControls 
includes an Advanced Find feature that can search across all mailboxes in an archive EDB file, 
rather than searching one mailbox at a time or bringing an old backup back online for analysis. And 
you can search by a variety of criteria, including keywords, subject, date and specific users.

Minimize storage space and the cost required to store and archive your backups. Because you 
don’t need to back up mailboxes individually doing a brick-level backup, you eliminate the backup 
space, cost, and time associated with performing brick-level backups.

Minimize the time to back up all mailboxes. Ontrack PowerControls for Exchange eliminates the 
need to back up mailboxes individually. Normally, companies do a full Exchange Server backup, 
and then run a second process to back up “Very Important Mailboxes” (VIMs) individually as well. 
Ontrack PowerControls eliminates this second process.
Copyright © 2010 Kroll Ontrack Inc. 1



I N T R O D U C T I O N
Ontrack PowerControls EnhancementsINTRODUCTION
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Ontrack PowerControls Enhancements

Ontrack PowerControls 6.0 contains all the features and benefits of Ontrack PowerControls 5.2 
plus these exciting new and improved features: 

• Support for Microsoft® Exchange 2007 SP2 and Exchange 2010
• Support for Windows Server® 2008 R2
• Support for Windows® 7 Professional, Enterprise, Ultimate
• Support for VMware® ESX 4.0

  

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
System Requirements

This section covers System Requirements for Ontrack PowerControls for Exchange and the 
minimum software requirements for Mailbox Creation Wizard.

Ontrack PowerControls for Exchange

To use Ontrack PowerControls for Exchange on your computer, you need the following hardware 
and software: 

• One of the following operating systems:
• Windows® XP Professional
• Windows Server® 2003
• Windows Server® 2008 Standard
• Windows Server 2008 Data Center
• Windows Server 2008 Enterprise
• Windows Server 2008 R2
• Windows Vista® Business
• Windows Vista Ultimate
• Windows Vista Enterprise
• Windows 7 Professional
• Windows 7 Enterprise
• Windows 7 Ultimate

Note:  Ontrack PowerControls in Windows Vista, Windows Server 2008, Windows Server 
2008 R2, and Windows 7 can only be run by users with administrative privileges and in 
administrative mode.

Note:  32-bit and 64-bit versions of the above operating systems are supported.
2 Copyright © 2010 Kroll Ontrack Inc.
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. .I N T R O D U C T I O N
System Requirements
Note:  The HASP HL override key functionality does not work on Windows Vista, Windows 
Server 2008, Windows Server 2008 R2, and Windows 7 operating systems when using a 
remote desktop connection to the computer.

• The following virtual environments are supported:
• VMware® Server 1.0x, 2.x
• VMware® Workstation v6.0x for Windows
• Microsoft® Virtual Server 2005 R2
• Microsoft® Hyper-V™
• Microsoft® Hyper-V Server™ 2008 R2
• Microsoft® Virtual PC 2007
• VMware® ESX 4.0, ESXi

Note:  Virtual operation of tape devices may have restrictions imposed by virtual operating 
systems.

Note:  HASP key operation is validated in environments that support USB attached devices 
and support the Kroll Ontrack-distributed HASP drivers only.

• Microsoft® Office Outlook 2000 or later. Machine must have Outlook 2000 or greater 
installed and Outlook must have been run at least once to configure settings in Outlook. 
Additionally, those versions of Outlook that make a distinction between “Internet Email” 
and “Corporate Email” need to be configured for the latter.

• For Microsoft® Exchange Server 5.5: Microsoft Outlook 2000 or Office Outlook® 
2003 is required.

Note:  Office Outlook® 2007 cannot connect to an Exchange Server 5.5. However, Outlook 
2007 can be used with Ontrack PowerControls to access an .edb file originating from an 
Exchange Server 5.5 environment.

• For Microsoft® Exchange Server 2000 and Microsoft® Exchange Server 2003: 
Microsoft Outlook 2000 or later is required.

• For Microsoft® Exchange Server 2007: Microsoft Outlook 2003, Outlook 2007, or 
Outlook 2010 is required. 

• For Microsoft® Exchange Server 2010: Microsoft Outlook 2003 or Outlook 2007 is 
required.

Note:  The operating systems listed above and Office Outlook® are required to have the latest 
service packs installed.

• Microsoft® .NET Framework 3.5
• Intel® Pentium® compatible processor 
• 1024 MB RAM minimum
• 200 MB of free hard disk space for the installation. More disk space will be needed for 

processing log files when opening an EDB file.
• Monitor with 800 x 600 or higher screen resolution 
Copyright © 2010 Kroll Ontrack Inc. 3



I N T R O D U C T I O N
System RequirementsINTRODUCTION
• USB port (for Ontrack PowerControls product licenses requiring HASP key dongle to run 
application)

Note:  Ontrack PowerControls supports Microsoft® Exchange Server 5.5, Exchange Server 2000, 
Exchange Server 2003, Exchange Server 2007 (including SP1 or SP2), or Exchange 2010 installed. 
Ontrack PowerControls may also run on the same server as Exchange Server 2007 (including SP1 
or SP2) or Exchange Server 2010 installed. Ontrack PowerControls does not support other 
Exchange Server installation configurations.

Ontrack PowerControls is designed to run from a Windows®-based workstation and uses native 
Microsoft® Messaging APIs (MAPI) to communicate to the Exchange Server, ensuring reliable and 
consistent operation of your server. For MAPI to initialize properly, Office Outlook must be 
installed and configured on the workstation to connect to an Exchange Server. When connecting to 
an Exchange Server 2007 (including SP1 or SP2) or Exchange Server 2010, Outlook 2003 or 
Outlook 2007 must be installed and configured.

Mailbox Creation Wizard

To use Mailbox Creation Wizard on your computer, you need these minimum software 
requirements.

The Exchange Management Tools can be installed on Windows® XP Professional, Windows® 
2000 Professional, Windows 2000 Server; Windows 2000 SP3, or Windows Server® 2003. To see 
additional supported operating system  and prerequisite requirements, please refer to the Exchange 
Management Tools documentation for your specific version. 

Exchange Server Software Required Prerequisites

Exchange Server 
2000

Exchange Server 2000 
Management Tools* 

Windows® 2000 Administrative Tools

Exchange Server 
2003

Exchange Server 2003 
Management Tools** 

Internet Information Server (IIS) 

Windows Server® 2003 SP1 
Administrative Tools Pack

Exchange Server 
2007

Exchange Server 2007 
Management Tools*** 
(64-bit: CD; 32-bit: 
download)

IIS

Microsoft® .NET Framework 2.0

Microsoft® Management Console (MMC 
3.0)

Windows® PowerShell 1.0

Exchange Server 
2010

Exchange 2010 
Management Tool

IIS 6 Management Console (Windows)

.NET Framework 3.5 SP1 (download)

Windows Management Framework Core 
(KB968930) - includes PowerShell 2.0 
and WinRM 2.0 (download)
4 Copyright © 2010 Kroll Ontrack Inc.
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. .I N T R O D U C T I O N
Configuring Microsoft® Office Outlook®
*The Exchange 2000 Management Tools can only be used on Exchange Server 2000 and can be 
installed on Windows XP Professional, Windows 2000 Professional, Windows 2000 Server, 
Windows 2000 SP3, or Windows Server 2003.

**The Exchange 2003 Management Tools can be used on Exchange Server 2000 or 2003 and can 
be installed on Windows XP Professional, Windows 2000 Professional, Windows 2000 Server SP3, 
or Windows Server 2003.

***The Exchange 2007 Management Tools can only be used on Exchange Server 2007 and can be 
installed on Windows XP Professional, Windows 2000 Professional, Windows 2000 Server SP3, or 
Windows Server 2003.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Configuring Microsoft® Office Outlook® 

Ontrack PowerControls requires that Microsoft® Messaging API (MAPI) be installed on your 
computer. To get full MAPI functionality, do the following before installing Ontrack 
PowerControls for Exchange:

1. Make sure that Office Outlook® is installed and has been run once.
2. Set up an email account on an Exchange Server.
3. For those versions of Outlook that distinguish between “Internet Email” and “Corporate 

Email,” use “Corporate Email” when configuring Outlook.
4. Run Outlook again, and connect to the Exchange Server.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Installing Ontrack PowerControls

Follow these steps to install Ontrack PowerControls for Exchange:

1. Install and configure Outlook as described in “Configuring Microsoft Office Outlook.”
2. Turn off any disk utility or antivirus program running in the background.
3. Insert the Ontrack PowerControls CD-ROM into your CD-ROM drive.
4. The installation program automatically starts. If it does not: 

• For Microsoft Vista, Windows Server 2008, and later: Click Run on the Start/All 
Programs/Accessories menu, and type D:\autorun.exe or D:\bin\setup.exe, where D 
is the drive letter of your CD-ROM drive. Click OK.

• For Windows Server 2003 and earlier: Click Run on the Start menu, and type 
D:\autorun.exe or D:\bin\setup.exe, where D is the drive letter of your CD-ROM 
drive. Click OK.

5. Follow the on-screen instructions.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Uninstalling Ontrack PowerControls

You can uninstall Ontrack PowerControls for Exchange by running the uninstall program.
Copyright © 2010 Kroll Ontrack Inc. 5



I N T R O D U C T I O N
Keyboard ShortcutsINTRODUCTION
1. Click Start and then click Control Panel.
2. In Control Panel: 

For Microsoft Vista, Windows Server 2008, and later: Click Uninstall a program under 
the Programs heading.

• Click Ontrack PowerControls 6.0, and then click Uninstall/Change.
For Windows Server 2003 and earlier: Click the Add or Remove Programs icon.

• Click Ontrack PowerControls 6.0, and then click Change/Remove.
• Click Yes when the confirmation dialog box appears.

3. Follow the on-screen instructions.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Keyboard Shortcuts

Menu Bar Keyboard Shortcut

File Menu

Open Source Ctrl+S

Open Target PST Ctrl+T

Open Target Exchange Server Ctrl+E

Close Store Ctrl+L

User Data Wizard Ctrl+W

Exit Alt+F4

Edit Menu

Copy Selection to Clipboard Ctrl+C

Paste Copied Item(s) Ctrl+V

Paste Special Ctrl+Y

Delete DEL

Rename Ctrl+R

New Folder Ctrl+N

New Mailbox Ctrl+M

Move To Folder (Microsoft Exchange 
Server as a target - Find window)

Ctrl+Shift+V
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Enabling the Licensed Agents
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Enabling the Licensed Agents

Each edition of Ontrack PowerControls software for Exchange is distributed with nine Ontrack 
PowerControls ExtractWizard Agents and three Ontrack PowerControls Agents for Exchange. The 
Ontrack PowerControls ExtractWizard Agent for Windows® NT Backup is included with the 
program at no extra cost, and is enabled by default. All other Agents are shipped with all Ontrack 
PowerControls editions in disabled conditions and require a new license file to enable them. See the 
Ontrack PowerControls ExtractWizard User Guide for more information.

Cut (Microsoft Exchange Server as a 
target - Find window)

Ctrl+X

View Menu

Refresh Screen F5

Tools Menu

Integrity Check Ctrl+I

Export Ctrl+P

Create Reports Ctrl+Q

Find F3

Online Help

View Help F1

Ontrack 
PowerControls 

ExtractWizard Agent
Versions 

Supported Disk Backup Tape Backup

Agent for Windows® 
NT Backup

All Versions .BKF Files Microsoft Tape 
Format (MTF)

Agent for Symantec™ 
Backup Exec™

8.x, 9.x, 10.1, 11.d, 
12.0, and 12.5

.BKF Files Microsoft Tape 
Format (MTF)

Agent for EMC® 
NetWorker®

6.x and 7.0 through 
7.53

.0 Files NetWorker Tape 
Format

Menu Bar Keyboard Shortcut
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Enabling the Licensed AgentsINTRODUCTION
1) For NetBackup 6.x backups created using Bare Metal Restore™ or Off-Host Backup, Ontrack 
recommends the Advanced Method for extraction.

2) For CA ARCserve 11.5 multiplexed backup tapes, Ontrack recommends the Advanced Method 
for extraction.

3) For EMC NetWorker 7.2, 7.3, 7.4, and 7.5 backups created using Advanced File Backups, 
Ontrack recommends the Advanced Method for extraction.

4) For IBM Tivoli Storage Manager 5.3, 5.4, and 5.5 backups created using Export mini format, 
Ontrack recommends the Advanced Method for extraction.

5) For CA ARCserve 11.5 SP3 backups of Microsoft Exchange Server 2007 created using 
Advanced Mode, Ontrack recommends the Direct method for extraction.

6) For CA ARCserve 12.0 backups of Microsoft Exchange Server, Ontrack recommends the Direct 
Method for extraction.

In addition to Ontrack PowerControls ExtractWizard Agents, Ontrack PowerControls users also 
have the option to purchase other unique add-on features for enhanced search and analysis 
capabilities for Exchange.

Agent for CA 
ARCserve® Backup

9.x, 11.52, 11.5 
SP32,5, and 12.0 
SP16

.CTF (ARCserve) 
Files

ARCserve Tape 
Format

Agent for Veritas™ 
NetBackup™

4.5, 5.x, 6.0, 6.51, 
6.5, and 6.5.3.11

_C1_F 
(NetBackup) Files

Veritas NetBackup 
Tape Format

Agent for IBM® 
Tivoli® Storage 
Manager

5.1, 5.2, 5.34, 5.44, 
and 5.54

.BFS and .OST 
Files

Tivoli Tape Format

Agent for Hewlett-
Packard OpenView® 
Storage Data Protector 

4.2, 5.x, and 6.0 User-Defined File 
Extension

Hewlett-Packard 
OpenView Storage 
Data Protector Tape 
Format

Agent for CommVault 
Galaxy® Backup & 
Recovery

5.0, 5.9, 6.1, 7.0, 
and 8.0

Backup Path CommVault Galaxy 
Tape Format

Agent for UltraBac 7.1 and 8.0 Magnetic Library UltraBac Software 
Tape Format

Agent for Native 
SharePoint Backups

STSADM and Site 
Administrator

.BAK Files Microsoft Tape 
Format (MTF)

Ontrack PowerControls Agent Version Supported

Agent for PST as Exchange Source Microsoft® Office Outlook 97 or later

Ontrack 
PowerControls 

ExtractWizard Agent
Versions 

Supported Disk Backup Tape Backup
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. .I N T R O D U C T I O N
About the Exchange Database
To view the currently enabled Agents 

• On the Help menu, click About and then click License Info.

To enable an Agent 

1. Contact a sales representative and specify which agent you wish to purchase. A license file 
containing the newly enabled agent will be sent to you. 

Note:  To contact a sales representative, see U.S. Contact Information.

2. Replace the existing .ini file with the new .ini file. The default location for this file is in the 
Ontrack PowerControls directory for Exchange. 

The License File

All Ontrack PowerControls editions for Exchange require a license file. The purpose of this file is 
to let you buy only those features you need. Before Ontrack PowerControls for Exchange is 
enabled, it checks the .ini file for five things:

• The license file must be valid for Ontrack PowerControls 6.0. 
• Mailbox limit if applicable.
• Server name enforcement if applicable. Allows users to open EDB files only from the 

licensed server names.
• Subscription length if applicable.
• Enabled Agents (Ontrack PowerControls ExtractWizard Agents, Ontrack PowerControls 

Agents for Exchange)

Tip:  If you have the Ontrack PowerControls Standard Edition (100 mailboxes), and you attempt to 
open an EDB file with 101 mailboxes, Ontrack PowerControls for Exchange will not open the file.

Note:  To view and/or change the location of the license file, see “Setting Preferences” on page 30. 
In the Ontrack PowerControls Preferences window, click the Options tab and read the instructions 
for the “License file name” preference.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
About the Exchange Database

The Exchange database consists of the following files:

• .edb file (rich text database file) contains data placed in the store through Messaging 
Application Programming Interface (MAPI), as well as all the database tables that define 
mailboxes, messages, folders, and attachments. 

Agent for Advanced Searching Not applicable

Agent for Content Analysis Store Not applicable

Agent for Administrative Services Not applicable
Copyright © 2010 Kroll Ontrack Inc. 9



I N T R O D U C T I O N
About the Exchange DatabaseINTRODUCTION
• .stm file (streaming database file) contains common Internet formatted content, such as 
Multipurpose Internet Mail Extensions (MIME) content, that protocols other than the MAPI 
protocol place in the store.  

Note:  The .stm file is new to Exchange 2000. Exchange 5.5 does not contain .stm files. 

• .log files (transaction logs) are history files recording server activity. These files are useful 
in restoring and backing up Exchange data. Transaction logs for Exchange Server 5.5, 2000, 
and 2003 are 5 MB in size. Transaction logs for Exchange Server 2007 and Exchange 
Server 2010 are 1 MB in size.

Each storage group uses its own set of transaction log files. For example, if a storage group 
contains five stores, all transactions for all five stores are recorded in a single series of 
transaction log files. You can determine where to locate the transaction log files for each 
storage group.

• .chk (check) files are checkpoint files used for recovering (playing) data from transaction 
logs into EDB files. The checkpoint is the place marker in the EDB.CHK file that indicates 
which transactions have been committed. Whenever data is written to an EDB file from the 
transaction log, the EDB.CHK file is updated with information specifying that the 
transaction was successfully committed to the respective EDB file. Separate Exx.chk files 
are maintained for each storage group using ESE (Extensible Storage Engine). 

• .pat (patch) files are used to record information on page splits in Exchange 5.5 through 
Exchange 2000 (SP1). In Exchange 2000 (SP2) and later, the functionality provided by .pat 
files is incorporated into Exchange log files.

Organizing the Exchange Database Files for Ontrack PowerControls

For best results when using an online incremental or differential backup

• Put the .edb, .stm, and .pat files in one directory. 
• Put the associated log files (e.g., .log, .chk) in one directory. 

Note:  The two directories can be different.

Ontrack PowerControls for Exchange does not require .stm or .log files, but you should include 
them to ensure that all email data is recovered. You may get corruption errors if these files are not 
present. 

If you are using an offline backup

You need to use the .edb and .stm files for offline backups. To ensure that all email data is 
recovered, you should also include all .log files, as well as .pat and .chk files if they exist. Ontrack 
PowerControls for Exchange performs its own verification process and includes the .log and .pat 
files to determine if it needs them to recover the data.
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. .I N T R O D U C T I O N
Upgrading Ontrack PowerControls
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Upgrading Ontrack PowerControls

If Ontrack PowerControls 5.2 has been previously installed, is active, and you are upgrading to 
Ontrack PowerControls 6.0, you will not be able to reuse the existing Ontrack PowerControls 5.2 
license file with Ontrack PowerControls 6.0. 

Upgrading Ontrack PowerControls when Kroll Ontrack Administrative Server is 
Required

If the Kroll Ontrack Administrative Server (KOAS) is required either through the use of the Agent 
for Administrative Services or for the Central Licensing Service (CLS), before upgrading Ontrack 
PowerControls, it is necessary to first upgrade your KOAS 1.2 server and optionally configure CLS 
to use your new Ontrack PowerControls 6.0 CLS license. Please see the KOAS user documentation 
for details on how to perform an upgrade installation. 

To upgrade site installations requiring KOAS when CLS is in use

1. Close down all Ontrack PowerControls clients.
2. Upgrade KOAS 1.2 to KOAS 6.0.
3. Start the KOAS management console to verify KOAS has upgraded.
4. Using the KOAS CLS plug-in, in the License File tab, configure KOAS 6.0 CLS to use the 

Ontrack PowerControls 6.0 CLS license file provided with the delivery of Ontrack 
PowerControls 6.0 and KOAS 6.0.

5. Follow the instructions and restart KOAS to ensure that CLS is running properly. If the 
wrong CLS license file is configured, an error displays in the CLS status displays.

6. Use existing Ontrack PowerControls 5.2 installation.

Note:  Ontrack PowerControls 5.2 installations can be upgraded to Ontrack PowerControls 
6.0 as required.

To upgrade site installations requiring KOAS when CLS is not in use

1. Close down all Ontrack PowerControls clients.
2. Upgrade KOAS 1.2 to KOAS 6.0.
3. Start the KOAS management console to verify KOAS has upgraded.
4. Use existing Ontrack PowerControls 5.2 installation.

Note:  Ontrack PowerControls 5.2 installations can be upgraded to Ontrack PowerControls 
6.0 as required.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Getting Help

Kroll Ontrack provides you with the following ways to get help with Ontrack PowerControls: 
“Online Help” and “Technical Support”.
Copyright © 2010 Kroll Ontrack Inc. 11



I N T R O D U C T I O N
Conventions in this ManualINTRODUCTION
Online Help

Online Help includes all of the information in the user guide and more, and it lets you quickly 
access this information by using one of three tabs. The Contents tab offers a hierarchical view of 
the contents of the user guide. The Search tab offers a full-text search of the user guide. The Index 
tab offers a keyword-based way to get to specific topics.

To start online Help

Do one of the following:

• On the Help menu, click Contents.
• Click  on the toolbar.
• Press the F1 key.

To identify a tool or control

• Position the pointer over a tool or control, and then pause. A tool tip shows the name of the 
item.

Technical Support

If you have questions or problems not answered in the user guide or the online Help (F1), call our 
Technical Support group. When reporting an issue, please include any information that might help 
us diagnose the problem. The following details are often the most helpful:

• The version of Ontrack PowerControls you are using (on the Help menu, click About).
• The versions of Windows operating systems and Outlook that you are running.
• The version of Exchange that contained the source EDB file.
• The circumstances and sequence of steps that led to the problem.
• The text of the error messages (if any appeared), and the contents of the Details window.
• A list of other Windows-based programs that you were running when the error occurred.

See “U.S. Contact Information” and “International Contact Information” at the beginning of this 
user guide.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Conventions in this Manual

This manual uses guidelines for documenting menu commands and shortcuts; commands available 
on shortcut menu; and notes and tips. 

Menu Commands and Shortcuts

This manual uses the following conventions for documenting menu commands and shortcuts:

Example Describes

On the File menu, point to Target PST, 
and then click Create New.

Choosing the Create New command on the 
Target PST submenu on the File menu.
12 Copyright © 2010 Kroll Ontrack Inc.
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. .I N T R O D U C T I O N
Conventions in this Manual
Shortcut Menu

You can access many of the same commands available on the menu bar and toolbar by right-
clicking the mouse to display a shortcut menu. The contents of the shortcut menu depend on 
whether you right-click in the source or target pane. This manual seeks to teach you how to use 
commands on the menu bar and toolbar, and doesn’t always specify when you can use the shortcut 
menu. Once you become familiar with Ontrack PowerControls for Exchange, the commands 
available to you on the shortcut menu should become apparent.

Notes and Tips

The notes and tips in this user guide follow the guidelines offered in the Microsoft Manual of Style 
for Technical Publications, 3rd Edition. Redmond, WA: Microsoft Press, 2004.

On the Edit menu, click Paste Special. Choosing the Paste Special command on the 
Edit menu.

Press Ctrl+S (Open source EDB) Holding down the Ctrl key and the S key at 
the same time and then releasing them.

Right-click Clicking the right mouse button.

Example Describes
Copyright © 2010 Kroll Ontrack Inc. 13
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CHAPTER 1

. . . . 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
LOOKING AT THE INTERFACE CHAPTER 3 : 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

This chapter describes the parts of the main Ontrack® PowerControls™ window for Exchange, and 
shows you how to preview messages, view details of an EDB, PST, or CAS file, and change the 
view.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Ontrack PowerControls Main Window for Exchange 

The Ontrack PowerControls main window for Exchange is where you do most of your work. This 
window displays the source EDB, PST, or CAS file(s) as well as the target PST file(s), Exchange 
Server or CAS. The target acts as a container for the restored files. The various work areas and 
controls are described in the following sections. 

Note:  In the illustration below, the target pane displays a PST that acts as a container for restored 
files. Keep in mind that the target pane could just as easily display an Exchange Server. 
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Figure 3-1. The main window with four panes

Source Pane

The source pane displays the EDB file(s) that you extracted from a disk or tape backup. The source 
pane can also display one or more PST files if you have purchased the “PST as Source File” agent. 
It also displays a content analysis store (CAS) as source. If you have not yet extracted Exchange 
data from a backup tape or disk, see the Ontrack PowerControls ExtractWizard User Guide.
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. .L O O K I N G  A T  T H E  I N T E R F A C E
Ontrack PowerControls Main Window for Exchange
Figure 3-2. Sample icons with descriptions below

Sources Root Node contains one or more source data stores that are pre-pended with 
a “SourceX” where X is a number starting with 1 and is incremented for each 
additional source opened. You can select the sources root node as your search source.

Source EDB File (e.g., ) contains the Exchange Information Store 
data that you extracted from a tape or disk backup. Click the plus sign (+) next to an 
EDB file to expand its contents.

Mailbox (e.g., ) contains the Outlook folders. Click the plus sign 
(+) next to a mailbox to expand its contents.

Outlook Folders (e.g.,  Inbox,  Contacts,  Tasks) contain Outlook 
message items. Select a folder to view its contents in the source message list.

Source CAS File (e.g., ) contains the content analysis store data created 
to analyze content based on certain criteria.

CAS Profile Folder (e.g., ) which contains the results of a 
content analysis.

Inaccessible Mailbox which displays if a mailbox is inaccessible.

An inaccessible mailbox will present no visible content. Source mailbox access is 
controlled by Ontrack PowerControls Agent for Administrative Services. If Ontrack 
PowerControls Agent for Administrative Services in enabled and Kroll Ontrack 
Administrative Services Mailbox Permissions Control functionality is active, source 
mailbox accessibility will be controlled via this functionality. Otherwise, source 
mailbox access is always permitted. Target mailbox access is controlled by the target 
Microsoft Exchange Server.

Status indicator which indicates that Ontrack PowerControls is licensed for the 
Agent for Administrative Services and that it is connected to Kroll Ontrack 
Administrative Server. This icon is located in the Status Bar of the Ontrack 
PowerControls main window.
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Note:  In the above illustration, the source pane displays an EDB file, but it could just as easily 
display a PST file, CAS, or even multiple EDB and PST files.

Source Message List

The source message list displays the message items in the Outlook folder that you selected in the 
source pane. This folder is one of the Outlook folders (e.g., Inbox, Contacts, Tasks). In the 
illustration below, the source message list displays the messages in an Inbox. 

Figure 3-3. The Source Message List

The source message list displays metadata about the message items in six columns. The metadata 
includes file type; attachments, if any; message sender; subject; date; and status. The Sent Items 
folder also displays the “To” column. For more information on the message list, see “Sorting 
Messages in the Message Lists” on page 25.

The source content analysis store message list includes file type; Database #, Database, and Path. 
The source content analysis store profile folder message list includes file type; Attachment, if any; 
From; Subject; Create Date; Database #; Folder, and Status. For more information on content 
analysis stores, see “Content Analysis Store” on page 139.

Target Pane

The target pane can display one or more target PST files and/or one target mailbox, public folders 
and mailboxes from an Exchange Server, and content analysis stores (CAS) with profile folders. 
The target acts as a container for your restored files. If a target is a newly created PST file, it 
defaults to 10 Outlook folders. If a target is an existing PST file or Exchange Server, it shows 
whatever folders are in the target. It is into these folders that you paste and restore your message 
items. For information on restoring message items, see “Restoring Exchange Data” on page 101.

Status indicator which indicates that Ontrack PowerControls is either not licensed for 
the Agent for Administrative Services or it is licensed but not connected to the Kroll 
Ontrack Administrative Server. This icon is located in the Status Bar of the Ontrack 
PowerControls main window.
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Ontrack PowerControls Main Window for Exchange
Figure 3-4. Target panes with PST, CAS, and Exchange Server files

Target Message List (Restored Messages)

The target message list displays the message items in the Outlook folder that you selected in the 
target pane. If the target is a newly created PST file or CAS, the Outlook folders and message list 
will be empty. If the target is an existing PST file, CAS file, or Exchange Server, or if you have 
restored message items to a newly created PST file, you can select a folder in the target pane to 
display messages in the target message list. 

Figure 3-5. Target Message List Displaying Restored Messages

The target message list displays metadata about the message items in five columns (instead of six 
columns in the source message list). The metadata includes file type; attachments, if any; message 
sender; Subject; and Create Date. The Sent Items folder also displays the “To” column. For more 
information on the message list, see “Sorting Messages in the Message Lists” on page 25.

The target content analysis store message list includes file type; Database #, Database, and Path. 
The target content analysis store profile folder message list includes file type; attachment, if any; 
From; Subject; Create Date; Database #; Folder; and Status. For more information on content 
analysis stores, see “Content Analysis Store” on page 139.

Target pane with PST 
files

Target pane with CAS 
files Target pane with Exchange 

Server
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Menu Bar

Figure 3-6. The Menu Bar in the main window

The menu bar contains most of the Ontrack PowerControls commands for Exchange. The menu 
commands, submenu commands, and resulting windows are discussed fully in the chapters that 
focus on those specific commands. See the Index to quickly locate the pages on which a menu 
command is discussed.

HELP MENU - ADMINISTRATIVE SERVICES

The Administrative Services option is available in the Help menu when the Ontrack PowerControls 
Agent for Administrative Services is active. It displays information regarding the Kroll Ontrack 
Administrative Server that Ontrack PowerControls is connected to and the services that are being 
used.

Note:  During normal operation, the auditing service (if activated) does not alter the behavior of 
Ontrack PowerControls.

Figure 3-7. Kroll Ontrack Administrative Server connection and service information

Toolbar

Figure 3-8. The Button Toolbar in the main window
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